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Congratulations on your purchase of the NeuroMod tXES 
System for transcranial electrical stimulation (tES) 
system. The NeuroMod tXES System is the most 
advanced neuromodulation device on the market. Please 
read this manual carefully and completely to ensure the 
safe and effective use of the NeuroMod tXES System. 

The NeuroMod tXES System is capable of all common 
types of tES including transcranial direct current 
stimulation (tDCS), transcranial alternating current 
stimulation (tACS), and transcranial random noise 
stimulation (tRNS). In addition, the NeuroMod System is 
uniquely capable of tXES - wherein the user has the 
ability to define the stimulation paradigm. Examples of 
common and tXES waveforms are shown in Figure 1. 
tXES allows the user to combine any of the elements of 
tDCS, tACS, and tRNS to create unique waveforms. 
Further, the waveforms can contain windowing 
functions, pulses, combinations of frequencies, and 
anything else the user can define. The NeuroMod tXES 
system can even replay EEG activity back to the subjects 
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       Introduction

The NeuroMod tXES System is for research use 
only. Medical use in any diagnosis or treatment for 

disease is strictly forbidden. 

Figure 1: The top row shows standard tES waveforms 
in black. The lower boxes show tXES waveforms in 
blue. Any waveform can be reproduced on up to 16 
fully independent channels with the NeuroMod tXES 
System. This is only a small sample of the capabilities 
of the NeuroMod tXES System.
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from which it was recorded. 

tXES waveforms can be created in any program that 
allows the user to write text files with comma separated 
values. Matlab scripts are included with the NeuroMod 
tXES System to create the tDCS, tACS, and tRNS 
waveforms like those shown in Figure 1. The Matlab 
scripts allow the user to vary the amplitude, duration, 
and frequency of the tDCS, tACS, and tRNS waveforms 
within limits and where applicable. Software to 
reproduce the tXES waveforms is also available. 

The NeuroMod tXES system can be used like any other 
table top tES device where the waveform is specified by 
the user and started with the push of a button on the 
front. However, the stimulator can also be externally 
triggered for inclusion in real-time, closed-loop systems. 
The stimulator comes with 2, 4, 8, and 16 fully 
independent, programmable channels, each of which, can 
deliver up to 2 mA of stimulation.

If you need assistance in addition to this manual, 
hardware and software support are available from the 
experts at Brain Vision or Santa Fe Neurosciences at the 
addresses below. We look forward to working with you.

Brain Vision: support@brainvision.com

Santa Fe Neurosciences: neuromod@sfneuro.com
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The NeuroMod tXES System basic kit comes with the 
hardware and software noted below and are depicted in 
Figure 2. 

• Hardware
• 1 NeuroMod tXES Stimulator
• 1 NeuroMod tXES Head Box
• 2-16 NeuroMod tXES Electrode Assemblies1

• 1 Forty Conductor Ribbon Cable
• 2 Keys
• 1 Internet Protocol Address Identifier
• 1 Consumables Package for 10 Subjects

• Software
• NeuroMod Controller Software
• Standard Waveform Library

• tDCS
• tACS
• tRNS
• Impedance Check

• tES Waveform Design Matlab Functions
• Documentation

• 1 Internet Protocol Address Identifier
• 1 Password Identifier
• 1 System Manual

There are optional hardware, software, and services that 
can be purchased to enhance or support the NeuroMod 
tXES System. A partial list is included below. Please 
contact Brain Vision or Rio Grande Neuroscience for 
information on availability and pricing. If you have 
ordered an optional item, it will be noted in the list below. 

•Hardware
• Optical Isolator for Ethernet Cable - this is 

necessary to isolate the participant from power 
line voltage if the NeuroMod Controller Software 
is being used from a computer that is plugged 
into the wall socket or an uninterruptible power 
supply (UPS) during stimulation. 

• Trigger Cables - these cables are used to 
externally trigger the NeuroMod tXES 
Stimulator. Trigger cables can be configured with 
1-3 BNC connectors. The NeuroMod tXES 
Stimulator can be triggered with any transistor-
transistor logic (TTL) pulse from an external 
device that is more than 2.5 V in amplitude. 
These cables are used to place the NeuroMod 
tXES Stimulator in a closed-loop system. 

• Polarity Trackers - these should be used with 

 The NeuroMod tXES System can be purchased with 2, 4, 8, or 16 fully independent channels. The number of electrode assemblies 1

will correspond to the number of channels in your device. Channel upgrades are available. 
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Figure 2: The contents of the NeuroMod tXES Kit. A: The NeuroMod tXES Stimulator. B: The NeuroMod tXES Head Box. C: 
NeuroMod tXES Electrodes. D: Consumables Kit. E: Software, Keys, Password, and IP indicator. F: Trigger Cables (Optional) 
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waveforms that are not charge balanced, i.e. do 
not have a zero mean across the duration of 
stimulation. tDCS and other stimulation 
paradigms that include DC offset are examples 
of waveforms that are not charge balanced. The 
lifetime of the NeuroMod tXES Electrodes can be 
significantly prolonged by reversing the polarity 
with each use. Polarity Trackers allow the user to 
track the polarity across multiple uses. 

• EEG Caps - these can be used to hold NeuroMod 
tXES Electrodes in place on the scalp. The caps 
come in configurations from 2-256 perforations 
that approximate the 10-20, 10-10, or 10-5 
International Systems for EEG electrode 
placement. NeuroMod tXES electrodes are 
placed into the perforations to hold them in 
place similar to EEG electrodes. These caps are 
especially useful when EEG is being recorded 
during tES. Custom cap configurations are also 
available. 

• Stacking Cables - these are used to coordinate 
the activities of multiple NeuroMod tXES 
Stimulators for ultra high density tXES. The 
stimulators have been tested in configurations 
up to 91 channels operating simultaneously and 
independently. 

• Alternative Gels - There are alternatives to Signs 
Gel from Parker Labs that are less expensive, 
easier to use, or simply preferred. The following 

gels have been tested with the NeuroMod tXES 
Stimulator. These gels are recommended only for 
charge balanced waveforms. 

• Spectra 360 (Parker Labs)
• Super Visc (Easy Cap)
• Electro-Gel (Electro-Cap)
• Ten20 (Weaver)

• Duplicate Items - any item in the NeuroMod 
tXES System can be ordered to augment the base 
kit. Commonly ordered items are extra 
electrodes, trigger cables for use of the 
NeuroMod tXES Stimulator in closed-loops 
systems, and additional consumables. 

•Software
• Exotic Waveform Library - A library of 

waveforms and Matlab functions to produce 
variants of those waveforms are available. The 
Matlab functions will produce any of the 
waveforms shown in Figure 1. 

• Additional Licenses - Additional seats for the 
tXES waveform generators and NeuroMod 
Controller Software are available. 

•Services and Support
• Waveform Design - Support for custom 

waveform design is in advanced tXES 
applications is available.

• Montage Design - Support for the development 
of montages that position the NeuroMod tXES 
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Electrodes on the scalp is available.
• Finite Element Modeling - finite element models 

are used to understand the calculated current 
distribution in the brain during tES. The models 
of current distributions can be produced using 
stock male and female models from the Santa Fe 
Neurosciences library or with MRIs from user 
specified individuals. The current distributions 
are available for electrode montages with 
cephalic and extra-cephalic electrodes. The 
output format can be specified by the user. 

• tXES Training - Basic training by video 
conference is included in the purchase of the 
stimulator. Additional and advanced training for 
the NeuroMod tXES system by phone, 
videoconference, or site visit are available. 

• Site Setup - Onsite setup and training for the 
NeuroMod tXES System is available. 

• Maintenance Contracts - The NeuroMod 
Stimulator is warrantied for two years from the 
date of delivery. The NeuroMod Electrodes are 
warrantied for 90 days from the date of delivery. 
Extended warranties beyond these periods are 
available through maintenance contracts. For 
maintenance contract details see Page XX. 

• Extended Technical Support - during the period 
of warranty of the NeuroMod tXES Stimulator 
and Electrodes technical support is included in 

the price of purchase. Technical support outside 
the period of the warranty is available as part of 
a maintenance contract or by the hour. 

The experts at Brain Vision or Santa Fe Neurosciences are 
always happy to discuss the applications of the 
NeuroMod tXES System in your experimental paradigms 
to ensure that you have what you need to meet your 
goals. Please do not hesitate to contact us when you have 
questions, suggestions, or requests. 

Brain Vision: support@brainvision.com

Santa Fe Neurosciences: neuromod@sfneuro.com
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The NeuroMod tXES Stimulator

The NeuroMod tXES Stimulator is shown in Figure 2 and 
indicated with the letter A. The NeuroMod tXES 
Stimulator delivers user specified tES currents by 
measuring the impedance between the NeuroMod tXES 
Electrodes and generating the necessary voltage 
differences to drive the specified current between the 
electrodes. In this respect, the NeuroMod tXES stimulator 
is exactly the same as other tES stimulators. NeuroMod 
tXES Stimulator is also fully capable of common tDCS, 
tACS, and tRNS paradigms. However, the NeuroMod 
tXES Stimulator differs importantly in the method and 
variety of tES waveforms that can be generated and 
delivered. Unlike other tES stimulators, the NeuroMod 
tXES stimulator is not limited to specific types of tES by 
an internal function generator. Instead, the NeuroMod 
tXES Stimulator plays back waveforms that are stored in 
memory much like audio or video content on a smart 
phone, tablet, or computer. The NeuroMod tXES 

Stimulator can deliver the waveforms on up to 16 fully 
independent channels that can playback the same or 
different waveforms simultaneously or in a specified 
temporal sequence. Thus, the user can do anything from 
multichannel tDCS to replicating the spatiotemporal 
sequence of events in electrophysiological recordings. 

The front panel of the stimulator has a locking ribbon 
cable connector, a button for manual activation with 
status indication by color, and a LED indicator to show 
the status of electrodes (Figure 3). 

Locking Ribbon Cable Connector: The ribbon cable 
connects to the NeuroMod tXES Stimulator to the Head 
Box that is described below. The ribbon cable is one meter 
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The components of the NeuroMod tXES 
Stimulator System are not fragile but can be 

irreparably damaged by drops, impacts, and rough 
handling. 

Please Handle with care. 

       NeuroMod tXES Hardware

NeuroMod tXES Stimulator Front Panel.

Figure 3: NeuroMod tXES Stimulator Front Panel. The 
locking ribbon cable connector is at bottom left. The 
manual activation button with illuminated status indicator 
is at top right. The electrode status indicator LED is at 
bottom right. 
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in length and can be extended by one meter without 
effecting the functioning of the NeuroMod tXES 
Stimulator. The locking ribbon cable connector has tabs 
on the left and right side that capture the ribbon cable 
when it is fully inserted. Push the tabs toward the center 
of the ribbon cable to lock the cable in place. 

The ribbon cable and connector are keyed to ensure 
insertion in the proper orientation. Forcing the ribbon 
cable into the connector if the key is improperly aligned 
can damage the NeuroMod tXES Stimulator and change 
the distribution of tES currents on the electrodes. Please 
take a moment to examine the ribbon cable and connector 
prior to connection. 

Manual Activation Button with Illuminated Status 
Indicator: The button for manual activation of the 
NeuroMod tXES Stimulator is on the upper right of the 
front panel as shown in Figure 3. The manual activation 
button is surrounded by a lighted ring. The ring can be on 
of four colors; blue indicating that the stimulator booted 
properly and is ready, green indicating that the stimulator 
is in run mode and waveform playback is active, yellow 
indicating that the stimulator is paused and waiting for 
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Caution: Pressing and holding the manual 
activation button for 10 seconds will return the 
NeuroMod tXES Stimulator to factory settings. 

This will make the stimulator unusable. Please use 
this option only at the direction of technical 
support staff from Brain Vision or Santa Fe 

Neurosciences. 

Figure 4: NeuroMod tXES Stimulator Status Indicator.
The ring of color around the manual activation button on 
the upper right portion of the front panel indicates the 
status of the stimulator.

NeuroMod tXES Stimulator Rear Panel.
Figure 5: NeuroMod tXES Stimulator Rear Panel. 
The rear panel has the input for triggers at the far left, 
battery status indicator at middle left, the charger connector 
at center, the ethernet connector at middle right, and the 
power switch at far right. 
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input, and red to indicate that playback of a waveform is 
finished. The indicator light is not illuminated when the 
NeuroMod tXES stimulator is off (Figure 4). 

Ready: Upon turning the NeuroMod tXES Stimulator on 
the lighted ring will turn blue when the stimulator has 
booted properly and is ready for input. 

Running: When the NeuroMod tXES Stimulator is 
playing back a waveform in response to manual input, 
software input, or external triggers the light will turn 
green. The running of any waveform can be paused by 
pressing the manual activation button or pressing the 
pause button in the NeuroMod tXES Stimulator Control 
Software described below. When the stimulator has been 
paused during a run pressing the manual activation 
button, the pause button in software, or the run button in 
software will resume the playback of the waveform. 

Paused: A yellow light surrounding the manual activation 
button of the NeuroMod tXES stimulator indicates that 
the unit is paused. When in Paused mode the stimulator 
is waiting for input. One way to place the stimulator is 
placed into Paused mode by pressing the manual 
activation button or software buttons during run status as 
described above. The NeuroMod tXES Stimulator is also 
in Paused mode when waiting for an external trigger to 
initiate the playback of a waveform. The use of external 
triggers for inclusion of the NeuroMod tXES Stimulator is 
discussed in detail below. 

Finished: The lighted indicator surrounding the manual 
activation button will be red when the stimulator has 
finished running a waveform that has been setup in the 
software to run once or for a specific length of time. Note: 
When the stimulator has been setup in software to run 
waveforms each time an external trigger is detected it will 
return to Paused mode, not Finished, after a waveform 
run is completed. When the stimulator is in Finished 
mode a single button press will return it to Ready. 
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Figure 5: NeuroMod tXES Electrode Status Indicator.
The status indicator will not be illuminated when the 
NeuroMod tXES Stimulator is off and will remain in this 
state until the impedance readings are taken after the user 
initiates the playback of a waveform. Green indicates that 
the impedance readings for all electrodes are under the 
threshold set by the user. Yellow indicates that at least one 
electrode is over the impedance limit. Red indicates that 
impedance readings cannot be taken and waveform 
playback will not be initiated. 
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NeuroMod tXES Electrode Status Indicator LED: At the 
bottom right of the front panel of the stimulator is an LED 
indicating the status of the NeuroMod tXES Electrodes 
(Figure 5). Each of the, up to 16, channels on the 
NeuroMod tXES Stimulator has two electrodes. The 
impedance across those electrodes is measured 
independently for each channel. The LED will be green 
when the measured impedances of all electrodes on all 
active channels are under the limit set by the user, 
typically 30 kOhms. The LED will change to yellow when 
the impedance across any electrode pair on any active 
channel in the tES montage rises above the threshold 
specified by the user.  If the NeuroMod tXES Stimulator 
cannot obtain impedance readings, detects a problem 
with the electrodes, or with sending the waveform to the 
electrodes, the status indicator will turn red. 

The rear panel of the NeuroMod tXES Stimulator is 
depicted in Figure 6. The rear panel has the connector for 
input of external triggers, the battery status indicator, the 
battery charging connector, the ethernet connector, and 
the power switch. 

Trigger Input Connector: The NeuroMod tXES 
Stimulator can be externally triggered. The external 
trigger port is designed to incorporate the stimulator into 
real-time, closed-loop systems where neuromodulation 
can be delivered in response to a behavioral, 
physiological, or neurological state. The TTL pulse must 
be between 3.2 and 10 volts, at least 1 mA, and at least 10 

ms in duration. All triggering and waveform playback 
operations in the NeuroMod tXES Stimulator are based 
on a single clock. Moreover, waveforms that are assigned 
to a trigger are preloaded into volatile memory. These 
factors allow the stimulator to deliver the waveforms 
with a 2 ms delay across all active channels. The 
stimulator has no variance in the onset of waveforms 
across channels or across multiple triggering events (see 
Weisend et al., 2017 in Appendix I). The stimulator has 
three independent trigger lines that can be used to control 

three different wave forms. Multiple waveforms can be 
delivered simultaneously or inputs from multiple devices 
can be used in a single stimulation paradigm. The trigger 
lines can be used alone or in combination using a Boolean 
‘or’ function where a trigger on line 1 or 2, 2 or 3, 1 or 3, 
or any line will elicit the playback of a waveform that is 
resident in memory. Thus, input from EEG or from 
behavioral performance can elicit playback of the same 
waveform. Similarly, two different waveforms both of 
which are set to trigger on 1 or 2 can be delivered 
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Caution: TTL pulses that exceed 10 Volts and 
improperly wired trigger cables can damage the 
NeuroMod tXES Stimulator. Please consult Brain 
Vision or Santa Fe Neurosciences if you intend to 

design your own TTL pulse or build your own 
trigger cable. 
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simultaneously. This unprecedented temporal reliability 
and flexibility using external triggers are among the most 
innovative features of the NeuroMod tXES Stimulator. 
The trigger input is optically isolated inside the 
stimulator to prevent any risk of the subject being 
shocked with power line voltages. Thus, it is not 
necessary to disconnect devices that send triggers to the 
NeuroMod tXES Stimulator from wall power. 

Battery Status Indicator: The battery status indicator is 
not illuminated when the battery is well changed enough 
to run 2 hours of continuous tDCS at 2 mA per channel 
across a 10 kOhm resistor (Figure 7). When the charge in 
the battery falls below this threshold, the light will be 
illuminated in yellow. When the charge remaining in the 

battery will not support 30 minutes of tDCS at 2 mA per 
channel across a 10 kOhm resistor the battery status 
indicator will be illuminated in red.

Battery Charging Connector: The three pronged 
connector receives input from the Tenergy 1.0 Amp Smart 
Charger that is provided with your NeuroMod tXES 
Stimulator. If you choose to charge the stimulator with a 
different charger please contact the technical support staff 
at Brain Vision or Santa Fe Neurosciences to discuss your 
options. The smart charger prevents overcharging of the 
battery. The connector from the charger has a locking 
collar that holds the charger connector securely to the 
NeuroMod tXES Stimulator. Lock the collar onto the 
connector to ensure proper charging of the stimulator. 

The battery charging port is physically disconnected from 
the hardware inside the stimulator when the power 
switch is activated to prevent any risk of the subject being 
shocked with power line voltages. Thus, it is good 
practice, but not necessary, to disconnect the NeuroMod 
tXES stimulator from the charger during use with human 
subjects. 

Ethernet Connector: A standard ethernet cable is used as 
the main interface with the NeuroMod tXES Stimulator. 
The ethernet cable connection provides a connection to 
the NeuroMod Controller Software graphical user 
interface (GUI) on an external computer. The GUI is 
necessary to setup the stimulator but not necessary to run 
the stimulator. When not connected to an external 
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Figure 7: Battery Status Indicator. The LED is unlit when 
the NeuroMod tXES Stimulator has enough charge for 
prolonged use. The indicator will turn to yellow when 
insufficiently charged for prolonged use and red when the 
charge is so low that the stimulator cannot be used.  
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computer with the ethernet cable the stimulator will 
perform based on the settings from the previous session. 
The ethernet port on the NeuroMod tXES Stimulator is 
NOT optically isolated. Thus, if the user chooses to 
monitor the performance of the stimulator using the 
NeuroMod Controller Software GUI on a computer that is 
plugged into the wall socket or an uninterruptible power 
supply (UPS) during stimulation it is necessary to use an 
in line optical ethernet isolator to protect the human 
subject from power line voltage.

Power Switch: A keyed, locking switched is used to 
power the NeuroMod tXES Stimulator on and off. The 
keyed mechanism ensures that the stimulator cannot be 
accidentally turned on and off. In addition, only those 
who have access to the keys can power the stimulator on 
and off. The keys should be removed the locking 
mechanism when the stimulator is on or off to prevent 
mechanical damage to the power switch.  

NeuroMod tXES Head Box

The NeuroMod tXES Head Box is shown in Figure 2 and 
indicated with the letter B. The head box connects to the 
NeuroMod tXES stimulator with a ribbon cable. The 
electrodes are plugged into 16 connectors that are at the 
top of the unit. 

Electrode Connectors: The top of the NeuroMod tXES 
Head Box has the electrode connectors shown in Figure 8. 
The connectors have 4 pins and a key tab to ensure that 
the electrodes are plugged in properly. The electrode 
connectors hold the NeuroMod tXES Electrodes firmly in 
place. Use care to hold the electrode connectors firmly 
when inserting or removing the electrodes. 

Ground Connector: The ground connector on the 
NeuroMod tXES Head Box ties into the ground for the 
NeuroMod tXES Stimulator. The ground connector is 
useful for 1) visualizing the output of the stimulator with 
an oscilloscope and 2) tying the grounds together for 
multiple pieces of equipment, i.e. EEG or other 
physiological recording equipment to guard against noise 
from drift based on multiple grounds. If the user would 
like this capability please contact Brain Vision or Santa Fe 
Neurosciences for a ground cable. 

Locking Ribbon Cable Connector: The ribbon cable 
connects to the NeuroMod tXES Head Box to the 
stimulator (Figure 9). The ribbon cable is one meter in 
length and can be extended by one meter without 
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Caution: The ethernet port on the NeuroMod tXES 
stimulator is NOT optically isolated. If the 

ethernet cable is connected to a computer that is 
plugged into a wall socket or an uninterruptible 

power supply during stimulation an in-line optical 
ethernet isolator is required.  



NeuroMod tXES System Manual (Version 1.1)

effecting the functioning of the NeuroMod tXES 
Stimulator. The locking ribbon cable connector has tabs 
on the left and right side that capture the ribbon cable 
when it is fully inserted. Push the tabs toward the center 

of the ribbon cable to lock the cable in place. 

The ribbon cable and connector are keyed to ensure 
insertion in the proper orientation. Forcing the ribbon 
cable into the connector if the key is improperly aligned 
can damage the NeuroMod tXES Head Box and change 
the distribution of tES currents on the electrodes. Please 
take a moment to examine the ribbon cable and connector 
prior to connection. 

NeuroMod tXES Electrode Assemblies

The NeuroMod tXES Electrode assemblies are shown in 
Figure 2 and are marked with the letter C. The electrodes 
make the connection between the NeuroMod tXES head 
box and the research participant. The NeuroMod tXES 
Electrode Assembly can be seen in Figure 10. The 
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Figure 8: Top of the NeuroMod tXES Head Box. 
The head box has connectors for up to 16 electrodes and a 
ground cable. 

Figure 9: Side of the NeuroMod tXES Head Box.
The locking ribbon cable connector on the side of the 
NeuroMod tXES Head Box is identical to that on the 
NeuroMod tXES stimulator. Note the key to guide proper 
insertion and the locking mechanism on the lateral edges 
of the connector.
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NeuroMod Electrode Assembly consists of a 
nonconducting base, a conductive electrode, and a non 
conductive top that holds the assembly together. The 
electrode assembly is filled with gel to make contact 
between the skin and the conductive electrode. The wires 
attached to the electrode terminate in a connector that can 
be inserted into any position on the NeuroMod tXES 
Head Box. The electrode base can be inserted into an EEG 
cap for holding the electrode assembly against the scalp 
in the standard EEG positions approximated by the 
electrode cap. 

Additional questions on the NeuroMod tXES hardware 
can be answered by experts at Brain Vision or Santa Fe 
Neurosciences. 

Brain Vision: support@brainvision.com

Santa Fe Neurosciences: neuromod@sfneuro.com
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Figure 10: NeuroMod tXES Electrode Assembly. The 
assembly comes in three parts. The non-conductive 
electrode base, the conductive electrode, and the non-
conductive electrode top. The base is filled with conductive 
gel to make contact between the electrode and the skin. 
The top holds the electrode into the base and provides a 
port for filling the electrode base with gel. In some 
electrode tops, the Brain Vision EEG electrode can be 
placed into the fill port for co-localized stimulation and 
recording. 

mailto:support@brainvision.com
mailto:neuromod@sfneuro.com
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The NeuroMod tXES Software consists of three parts; 1) 
The NeuroMod tXES Controller graphical user interface 
(GUI) that is used to setup the stimulation protocol and 
monitor the performance of the NeuroMod tXES 
Stimulator, 2) a package of standard tDCS, tACS, and 
tRNS waveforms, and 3) Matlab scripts that allow the 
user to create custom tDCS, tACS, and tRNS scripts. 

The NeuroMod tXES Controller GUI 

The NeuroMod tXES Controller GUI can be seen in 
Figure 11. The GUI is the main interface by which the 
user can setup the playback of the waveforms stored on 
the NeuroMod tXES Stimulator and monitor the 
performance of the device during stimulation. The GUI 
has a menu bar with drop down choices and three 
sections of content arranged from top to bottom. The top 
section sets the options for playback of the waveform. In 
the center section the user selects the channels to deliver 
the tES waveforms. The bottom section allows the user to 
select the waveforms for playback, upload stimulation 
logs, and start, stop, or pause the stimulator. 

NeuroMod tXES Controller GUI - Stimulation Settings 
(Top Box): The top box determines how the waveform 
playback can be initiated and repeated. 

• Enable Trigger Input: When this box is unchecked, TTL 
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       NeuroMod tXES Software

Figure 11: NeuroMod tXES Controller GUI. The GUI is the 
main interface by which the user can setup the playback of 
waveforms stored on the NeuroMod tXES stimulator and 
monitor the performance of the device. In the display 
above the NeuroMod tXES Stimulator is being run in One-
Shot mode, with channels 1-4 included in the montage. The 
green indicators show that the channel impedances are 
within range while the yellow indicator shows that channel 
2 has been turned off because there was a high impedance 
reading. The display shows waveform files loaded into the 
Default and Trigger 1 boxes. Indicators in the lower left 
corner show that the NeuroMod tXES Stimulator is 
connected to the software and that the battery is full.  
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pulses on trigger lines will not activate the playback of 
a waveform. When this box is checked, the NeuroMod 
tXES Stimulator enters Pause mode when the 
Hardware or software Play buttons are pressed and 
waits for the specified trigger to initiate playback of the 
specified waveform. Checking this box also unmasks 
the Enable Re-Trigger check box. 

• Enable Re-Trigger: When this box is unchecked, the 
NeuroMod tXES stimulator enters Pause mode when 
the Hardware or software Play buttons are pressed and 
waits for the specified trigger to initiate playback of the 
specified waveform.  The specified waveform will be 
played back once, the stimulator will move to finished 
mode, and additional triggers will be ignored. When 
the box is checked, the NeuroMod tXES stimulator 
enters Pause mode when the Hardware or software 
Play buttons are pressed and waits for the specified 
trigger to initiate playback of the specified waveform. 
The specified waveform will be played back once, the 
stimulator will return to Pause mode, and additional 
triggers will initiate additional playback of the 
specified waveform. 

• Trigger: The waveform specified in the box labeled 
“Trigger 1” can be triggered by a TTL pulse on Trigger 
Line 1 or by combinations of triggers as specified in the 
drop down menu. 

• Trigger 1: Initiates playback of the specified 
waveform with TTL pulses on Trigger Line 1.

• Trigger 2: Initiates playback of the specified 
waveform with TTL pulses on Trigger Line 2.

• Trigger 3: Initiates playback of the specified 
waveform with TTL pulses on Trigger Line 3. 

• Trigger 1 or 2: Initiates playback of the specified 
waveform with TTL pulses on Trigger Lines 1 or 2.

• Trigger 1 or 3: Initiates playback of the specified 
waveform with TTL pulses on Trigger Lines 1 or 3.

• Trigger 2 or 3: Initiates playback of the specified 
waveform with TTL pulses on Trigger Lines 2 or 3.

• Any Trigger: Initiates playback of the specified 
waveform with TTL pulses on Trigger Lines 1, 2, or 
3.

• Trigger Polarity: Normal detects TTL pulses that have a 
zero baseline and rise to 3.2 V or more. Inverted detects 
TTL pulses that have a 5 V baseline and decrease to 1.8 
V or less. 

• Trigger Edge: Rising detects the leading edge of a TTL 
pulse. Falling detects the trailing edge of a TTL pulse. 

• Continuous: When this box is unchecked, the waveform 
is played back once in response to a Trigger or the 
hardware or software Play buttons. When this box is 
checked, a waveform is played back continuously in 
response to pressing the hardware or software play 
buttons until it is stopped manually by pressing the 
hardware or software Stop buttons. 
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• One-Shot: When this box is unchecked, the NeuroMod 
tXES Stimulator is placed in Continuous mode. When 
the box is checked, the stimulator plays back the 
specified waveform once in response to a Trigger or the 
hardware or software Play buttons. 

• Time Limited Run: When this box is unchecked, the 
length of the continuous run is unlimited and 
terminated only by the pressing of the hardware or 
software Stop buttons. When this box is checked, a 
number must be entered into the box to the right of the 
checkbox. The number specifies the number of seconds 
for continuous delivery of the waveform. The 
waveform will be delivered continuously for the 
specified length of time. At any time during this time-
limited, continuous playback pressing the hardware or 
software Stop buttons will terminate the delivery of the 
waveform. 

• tACS should be delivered using a time-limited, 
continuous delivery of a sine wave.

• tRNS should be delivered using a time-limited 
continuous delivery of a vector of random numbers. 

NeuroMod tXES Controller GUI - Channel Status 
(Center Box): The center box determines which channels 
are active or inactive and displays the status of the active 
channels via colored circular indicators. 

• Virtual Channel Selector Buttons: Channels can be 
activated or inactivated by pressing the virtual button 

with the numbers 1 through 16. The activated channels 
have black text and borders. Inactive channels have 
gray text and borders. 

• In the activated channels there is a circular colored 
indicator that indicates the status of the activated 
channel. The indicator will only show a color after the 
playback of a waveform has been initiated. 

• Green Indicator: Impedance across this channel is 
within the limit on the settings page, 30 kOhms by 
default. The specified waveform will be delivered on 
this channel. 

• Yellow Indicator: Impedance across this channel is 
outside the limit on the settings page. The specified 
waveform will not be delivered on this channel.

• Red Indicator: Impedance readings cannot be taken 
on this channel. The specified waveform will not be 
delivered on this channel. Please contact the experts 
at Brain Vision or Santa Fe Neurosciences to help 
resolve this issue. 

• Inactivated channels will not play back the selected 
waveforms. Impedance readings will not be taken on 
inactive channels. 

• The number of channels that can be activated is 
determined by the version of the stimulator that was 
purchased. With a 2, 4, or 8-channel stimulators any 
two, four, or eight channels can be activated. With 16-
channel stimulators all channels can be activated. 
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NOTE: If the number of channels activated is greater 
than the capability of the stimulator, waveforms will be 
delivered only on the channels with the lowest 
numbers. 

NeuroMod tXES Controller GUI - Waveforms and 
Stimulator Status (Bottom Box): The bottom box shows 
the selected waveforms and the status of the stimulator. 

• The upper left corner shows the maximum voltage 
output of the stimulator, ±35 V by default. This 
describes the upper limit of the voltage and is not a 
measure of the voltage across the electrodes. 

• The upper right corner has a software button that 
uploads the stimulation logs to the directory specified 
in the settings. 

• The Active Waveforms shows the files that are 
specified for playback. 

• Default: The waveform in this box will be played 
back when the Enable Trigger Input option is not 
selected and the hardware or software Play buttons 
are pressed. The waveform will play back in One-
Shot or Continuous mode as specified. 

• Trigger 1: The waveform in this box will be played 
back when the Enable Trigger Input or Enable Re-
Trigger in response to a TTL pulse on Trigger Line 1 
or with an alternative trigger as specified in the 
description above. The waveform will play back in 
One-Shot or Continuous mode as specified. 

• Trigger 2: The waveform in this box will be played 
back when the Enable Trigger Input or Enable Re-
Trigger in response to a TTL pulse on Trigger Line 2. 
The waveform will play back in One-Shot or 
Continuous mode as specified. 

• Trigger 3: The waveform in this box will be played 
back when the Enable Trigger Input or Enable Re-
Trigger in response to a TTL pulse on Trigger Line 3. 
The waveform will play back in One-Shot or 
Continuous mode as specified. 

• Waveforms are specified in each box by depressing the 
virtual “…” button and navigating to the waveform 
file, highlighting it with a single click, and pressing the 
Open button.

• A battery status indicator is located in the lower left 
corner. 

• A connection status message is shown in the lower left 
border. 

• “Not Connected” indicates that the GUI is not 
interacting with the NeuroMod tXES stimulator. No 
waveforms can be delivered by pressing the software 
Play, Pause, or Stop buttons. The hardware Play, 
Pause, Stop button on the NeuroMod device will 
deliver the waveform with the options that were set 
in the previous session. 

• “Connected to NeuroMod16” indicates that the GUI 
has found and is communicating with the 
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NeuroMod tXES Stimulator. The hardware and 
software Play, Pause, and Stop buttons have similar 
functionality. 

• A timer in the center bottom shows the time elapsed in 
the replay of a waveform. A message displaying the 
message HV On will flash when the stimulator is 
engaged in or paused during playback of a waveform.

• Bottom Right has the software Play, Pause, and Stop 

buttons. 

• Play: Initiates the replay of the specified waveform in 
the Default box or places the stimulator in to Pause 
mode to await a trigger depending on the 
specifications at the top of the NeuroMod tXES 
software GUI window. 

• Pause: Pauses the waveform playback on the first 
press. A second press resumes playback of the 

waveform. 

• Stop: Stops the playback of the waveform or 
terminates waiting for a trigger and places the 
NeuroMod tXES Stimulator in Finished mode. 

Drop down options in the Menu Bar: The choices in the 
drop down menus will be represented with the syntax 
top level > lower level and followed with a description of 
the effects of selecting an option. For quick reference the 
information will be presented in a bulleted list. 

• File > Save Configuration: Selecting this option saves 
the options that are selected in a file called “gizmo.cfg”.

•  This configuration file is updated automatically on 
exit of the NeuroMod tXES Controller GUI. 

• This configuration file must be present in the same 
directory from which the GUI is launched. 

• Starting the NeuroMod tXES Controller GUI without 
a configuration file in the same directory will cause 
an inability to connect with the stimulator via the 
ethernet port. 

• Configuration files that are specific for individual 
experiments can be stored in different directories. 
For example, a directory entitled “MyExperiment1” 
containing the controller software and configuration 
file will open a GUI with the settings for experiment 
1. A separate directory, “MyExperiment2”, with a 
second copy of the GUI and configuration file will 
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If the stimulator becomes unresponsive to the 
hardware or software Pause or Stop buttons, 
stimulation can be terminated in three ways. 
1) Turn the Power Switch to the off position. 
2) Disconnect the ribbon cable from the front of 

the stimulator. 
3) Disconnect the ribbon cable from the Head 

Box.
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open a GUI with the settings for experiment 2. 

• File > Exit: Selecting this option closes the NeuroMod 
tXES controller software.

• The configuration file is updated automatically upon 
exit of the GUI. 

• If the ethernet port is disconnected while the GUI is 
active and the NeuroMod tXES Stimulator is on, the 
user will need to reconnect the ethernet cable then 
exit and restart the GUI to connect with the 
stimulation device.

• View >  Channel Impedances: Selecting this option 
brings up a window that shows the channels, the 
measured impedances, and the status of the channel. 
This can be seen in Figure 12. 

• View > Waveform List: Selecting this option brings up 
a menu that shows the waveforms that are stored on 
the device and provides options Ok, Add, Delete, 
Refresh, Clear, and Cancel. 

• View > Waveform List > Ok: Selecting this option 
places the selected waveform into the Default box on 
the GUI. 

• View > Waveform List > Add: Selecting this option 
allows the user to add waveforms to the memory on 
the NeuroMod tXES Stimulator. 

• The password for the NeuroMod tXES Stimulator 
is required to add waveforms.

• When the correct password is entered, a window 
is displayed with directory and file information.

• The user can navigate to the directory where the 
waveforms are stored and select 1 or more files to 
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Figure 12: Display of channel impedances. The left column 
shows the channel number, the center shows the 
impedance measured across the channel, and the right 
column shows the status of the channel. True indicates that 
the channel is active and on. False indicates that the 
channel was not selected as part of the montage or that the 
channel has been turned off as a result of high impedance. 
In the display above, Channels 1-4 have been turned on 
and channel two has been deactivated as a result of a high 
impedance measurement.  
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be added to the memory on the stimulator. 

• View > Waveform List > Delete: Selecting this option 
removes the selected waveform from the memory of 
the NeuroMod tXES Stimulator. 

• View > Waveform List > Refresh: Selecting this 
option refreshes the list of waveform files that are 
stored on the stimulator. 

• View > Waveform List > Clear: This option clears the 
selected waveform and allows the user to select a 
different waveform for placement in the Default box 
on the GUI. 

• View > Waveform List > Cancel: Selecting this option 
cancels the selection of a new waveform for the 
Default box in the GUI and closes the window 
showing the waveforms stored on the NeuroMod 
tXES Stimulator. 

• Hardware Setup > Setup Screen: Selecting this option 
brings up a window that allows the user access to 
advanced settings. Changing the factory settings can 
effect the functioning of the NeuroMod tXES 
stimulator. The settings that should be changed only in 
consultation with the experts at Brain Vision or Santa 
Fe Neurosciences are marked below with an asterisk 
(*). These advanced settings can be seen in Figure 13. 
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* Changing this setting can negatively effect the performance of the NeuroMod tXES Stimulator. Please contact the experts at Brain Vision or 
Santa Fe Neurosciences before making any changes. 

Figure 13: The Setup Screen for the NeuroMod tXES 
Stimulator. With few exceptions, these should not be 
changed. The settings that should remain fixed are marked 
with an asterisk (*) in the manual. If the settings need to be 
changed please contact the experts at Brain Vision or Santa 
Fe NeuroSciences. 
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• * Hardware Setup > Setup Screen > Maximum 
Output Voltage*: This setting determines the voltage 
range of the device. The default setting is ±35 V. The 
maximum capacity of the system is ±40V. However, 
this pushes the electronics of the system to their 
maximum capacity. Prolonged use at the voltage 
maxima may reduce the lifetime of the electronics 
and the battery life. If you change this value it 
should decrease, not increase above ±35V.

• * Hardware Setup > Setup Screen > Open Circuit 
Threshold Level (kOhms): This setting determines 
the impedance value that will be considered an open 
circuit, i.e. a bad or disconnected electrode. The user 
can determine the value that is appropriate for their 
experiments. However, the user should keep in mind 
that the equation V=IR (where V is voltage, I is 
current, and R is resistance or impedance) sets limits 
for the current that can be delivered at high 
impedances. For example, 35 V across a 30 kOhm 
impedance means the maximum current that can be 
delivered is the voltage/impedance or 1.167 mA. At 
the ±35 V maximum it is critical to get impedances 
under 17.5 kOhms to ensure a 2 mA current will be 
delivered on a channel. 

• * Hardware Setup > Setup Screen > Impedance 

Monitor Frequency (Hz): This setting determines the 
number of impedance readings that are taken each 
second while a waveform is being delivered. High 
numbers (greater than 100) negatively impact the 
performance of the stimulator in changing the 
current at specified times. Low values cause 
increased variance in the impedance reading during 
subject movement. 

• * Hardware Setup > Setup Screen > Impedance 
Monitor Averaging Period (s): This setting 
determines the period over which the impedance 
readings are averaged to assess the quality of the 
connection between the electrodes and the skin. The 
default setting of 1 causes the impedance to be 
evaluated each second. An impedance reading above 
the user determined threshold deactivates the 
channel. Similarly, a setting of 5 evaluates the 
impedance after 5 seconds. The functional effect of 
this setting is to evaluate the impedance over the 
specified period of seconds and shut down the 
channel to ensure the safety of the subject. 

• * Hardware Setup > Setup Screen > Min Impedance 
Voltage (V): This setting determines the voltage at 
which samples are excluded from the impedance 
calculation. When the current specification is near 
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* Changing this setting can negatively effect the performance of the NeuroMod tXES Stimulator. Please contact the experts at Brain Vision or 
Santa Fe Neurosciences before making any changes. 
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zero; as in a sine wave that is crossing the zero line, a 
zero voltage specification for a waveform that has a 
built in pause or delay, or tRNS specification where 
the mA are near the zero line; V=IR can give a zero in 
the numerator of the equation. This causes an error 
that dramatically underestimates the impedance and 
can cause volatility in the impedance calculation. 
Excluding samples below a minimum voltage 
prevents this error. 

• * Hardware Setup > Setup Screen > Min Impedance 
Amperage (mA): This setting determines the current 
at which samples are excluded from the impedance 
calculation. When the current specification is near 
zero; as in a sine wave that is crossing the zero line, a 
zero voltage specification for a waveform that has a 
built in pause or delay, or tRNS specification where 
the mA specification is near zero; V=IR can give a 
divide by zero error that dramatically overestimates 
the impedance calculation and may shut down a 
channel improperly. Excluding samples below a 
minimum amperage prevents this error. 

• Hardware Setup > Setup Screen > Disable Individual 
Channels When They Exceed Threshold Impedance: 
When this box is checked individual channels with 
impedances higher than the Open Circuit Threshold 

are turned off and tES continues on channels where 
the impedance is below the open circuit threshold. 
This changes the tES montage. When the box is 
unchecked tES stops on all channels when impedance 
on any channel exceeds the Open Circuit Threshold. 

• * Hardware Setup > Setup Screen > Serial Number: 
The serial number of your device should match the 
label on the top of the NeuroMod tXES Stimulator. 
The Serial Number is linked to the licensing 
information and should not be changed.

• * Hardware Setup > Setup Screen > IP Address: The 
NeuroMod tXES Stimulator communicates with an 
attached computer via a ethernet port. The address 
of the device is set to 192.168.100.1XX, where XX are 
the last two numbers of the serial number. If this 
number needs to be changed as a result of a conflict 
with another network device, please contact the the 
experts at Brain Vision or Santa Fe Neurosciences for 
assistance. 

• * Hardware Setup > Setup Screen > Netmask: The 
Netmask should be set to 255.255.255.0 and should 
not be changed. 

• * Hardware Setup > Setup Screen > Gateway: The 
Gateway should be set to 0.0.0.0 and should not be 
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changed. 

• Hardware Setup > Setup Screen > Enable Single 
Ended Channels: Selecting this option for any 
channel delivers the specified waveform on only the 
electrode with the white wire and the black wire is 
inert. In Single Ended mode, it is the responsibility of 
the user to balance the positive and negative currents 
across the electrodes. The single ended mode is 
useful for advanced applications such at replicating 
the high density tES paradigms or current steering 
using multiple electrodes. Improper use of this 
option can damage the NeuroMod tXES device and 
increase the risk to the subject. Please consult with 
the experts at Brain Vision or Santa Fe Neurosciences 
before use. 

• Hardware Setup > Setup Screen > Send to 
NeuroMod16: Any changes to the settings in any 
field on the Settings Page must be sent to the 
NeuroMod tXES Stimulator before they will become 
effective. Please use this button only when you are 
certain you want to make changes to the settings. 

• * Hardware Setup > Setup Screen > Firmware 
Update: When a firmware update is required this can 
be used in collaboration with the experts at Brain 

Vision or Santa Fe Neurosciences. 

• * Hardware Setup > Setup Screen > Software Update: 
When a software update is required this can be used 
in collaboration with the experts at Brain Vision or 
Santa Fe Neurosciences.

• Hardware Setup > Setup Screen > Log Directory: The 
user should set the directory where log files should 
be stored when uploaded. The directory should be 
selected by pressing the “…” button and navigating 
to the directory, highlighting it with a single click, 
and pressing the Open button. 

• * Hardware Setup > Setup Screen > License File: 
When a license update is required this can be used in 
collaboration with the experts at Brain Vision or 
Santa Fe Neurosciences.

• Hardware Setup > Restart NeuroMod16: Selecting this 
option restarts the internal software on the NeuroMod 
tXES Stimulator. This will terminate the delivery of all 
waveforms or wait modes for triggers. This is 
sometimes necessary after a software upgrade and 
under rare circumstances where the stimulator does 
not respond as expected. 

• About > Version: Selecting this option displays 
hardware and software information that is useful if 

Santa Fe Neurosciences Page !  of !25 33

* Changing this setting can negatively effect the performance of the NeuroMod tXES Stimulator. Please contact the experts at Brain Vision or 
Santa Fe Neurosciences before making any changes. 



NeuroMod tXES System Manual (Version 1.1)

troubleshooting is required.  The information includes 
GUI build date, GUI version, Application Date and 
Time, Application Version, Operating System Date and 
Time, Device Serial Number, and Hardware Serial 
Number. 

Additional questions on the NeuroMod tXES Software 
can be answered by experts at Brain Vision or Santa Fe 
Neurosciences. 

Brain Vision: support@brainvision.com

Santa Fe Neurosciences: neuromod@sfneuro.com
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The NeuroMod tXES Electrodes can be seen in Figure 10. 
To apply the electrodes use the instructions below with 
the illustrations in Figure 14. 

• Clean the skin where the electrodes will be applied 
with an alcohol wipe. 

• Place the electrode base into the a retention device 
(electrode cap, Surgelast, Santa Fe Neurosciences 
Electrode Retainer).  

• Place the electrode in the base. 

• Put the electrode top in place. 

• Fill the electrode assembly with conductive gel. 

• Ensure that the gel fills the entire electrode assembly 
and area of the skin interface by moving the gel around 
to the inner edges of the electrode base with a cotton 
tipped applicator, blunt syringe needle, or similar.

• The goal is to move the spread the gel without 
abrading the skin. 

• The use of instruments with sharp edges is 
discouraged. 

• Refill the electrode assembly until gel exits the relief 
slot in the electrode top. 

• Check the impedance using the NeuroMod tXES 
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       NeuroMod tXES Electrode Use

Figure 14: Setup of the NeuroMod tXES 
Electrodes. See detailed instructions for 
assembly and filling with gel in the text.
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Stimulator or other impedance checking device. 

• High impedances can typically be corrected with 
moving increasing the homogeneity of gel at the skin 
interface (removing air bubbles). 

• Impedances typically get lower with time. Gelling 
the electrodes early in the visit of the research subject 
is advantageous.  

The NeuroMod tXES Electrodes require regular cleaning 
and maintenance to prolong their useful life time. 

• With maintenance the electrodes can be used 
indefinitely. 

• Without maintenance the electrodes will fail 
unpredictably after 6 to 10 uses in unbalanced 
waveforms like tDCS or tRNS. 

• In tDCS and tRNS parallel waveforms with inverted 
polarities (anodal and cathodal) should be created. 
After each use the waveform with an inverted 
polarity should be run while the electrodes are 
immersed in the same gel used during stimulation to 
recondition the electrodes. The electrodes should be 
throughly cleaned in immersed briefly in alcohol 
prior to reuse. 

• In tACS the waveform is typically balanced and only 
cleaning and brief immersion in alcohol is necessary 
to properly maintain electrodes. 
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There are 4 Matlab functions that are provided for the 
user to create or view the contents of a waveform file. The 
waveforms can create tDCS, tACS, or tRNS waveforms. 

General Notes:

• The function numSubplots is required to use the 
functions described below. Please obtain the function 
from https://www.mathworks.com/matlabcentral/
fileexchange/26310-numsubplots-neatly-arrange-
subplots before use. 

• The format of the waveform files is a four column 
matrix in CSV format. The first column gives the times 
when the amplitude of the current should be updated. 
The second column gives the channel numbers. The 
third column gives the values in mA for the stimulation 
waveform. The fourth column contains a vector of 
zeros. The time and amplitude vectors much be 
repeated for each channel. Please consult with the 
experts at Brain Visions or Santa Fe Neurosciences 
before attempting to create your own waveforms. 

Brain Vision: support@brainvision.com

Santa Fe Neurosciences: neuromod@sfneuro.com

NeuroModTACSWaveform.m: tACS waveforms can be 
created with user specifications using this Matlab 
function. 

Example: NeuroModTACSWaveform(10,0,0,10,2,4,’/
Users/mydata/mywaveforms/') will create a 10 Hz sine 
wave that starts and stops at full strength because the rise 
and fall times are zero. The length of the waveform will 
be 10 seconds. The peak amplitude will be ±2mA. The 
current will be divided across 4 electrodes. The waveform 
and image depicting the waveforms will be stored in the 
Users/mydata/mywaveforms directory. 

• Format: function [] = NeuroModTACSWaveform 
(stimFreq,riseTime,fallTime,durationAtMax,maxAmpli
tude,montageN,saveDir)

• Inputs:

• stimFreq: the frequency of the tACS (Hz)

• riseTime: the time over which the amplitude of 
stimulation increases from zero to maximum 
(seconds)

• fallTime: the time over which the amplitude of 
stimulation falls from maximum to to zero (seconds)

• durationAtMax: the duration of stimulation at 
maximum amplitude (seconds)

• maxAmplutude: the amplitude of stimulation at 
maximum (mA)
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• montageN: the number of channels the current will 
be divided across (integer from 1-16)

• saveDir: directory where waveform files will be 
saved (‘text')

• Outputs:

• File and figure saved to saveDir

• Notes:

• Large waveforms negatively effect the performance 
of the NeuroMod tXES Stimulator. It is preferred to 
specify a small number of cycles of a sine wave at 
relatively high fidelity (100 points) and repeat the 
sine wave for a specified number of seconds instead 
of creating a large waveform with many cycles of the 
sine wave. 

• tACS sine waves with very large numbers of points 
may exceed the 25 𝜇A resolution of the NeuroMod 
tXES device. Thus, the waveform will not change 
until the threshold is exceeded. 

• The NeuroMod tXES Stimulator defines the 
amplitude of the tACS waveform from baseline to 
peak similar to the Soterix stimulators. This is unlike 
the NeuroConn stimulator that defines the 
amplitude of the waveform from peak to peak. 

• The number of subplots in the image will reflect the 
number of channels that have been included in the 
stimulation montage. 

NeuroModTDCSWaveform.m: tDCS waveforms can be 
created with user specifications using this Matlab 
function. 

Example: NeuroModTDCSWaveform(15,15,1800,2,4,'/
Users/mydata/mywaveforms/') will create a DC 
waveform that rises to maximum over 15 seconds and 
falls to zero over 15 seconds. The length of the 
stimulation at maximum current will be 1800 seconds. 
The peak amplitude will be +2mA. The current will be 
divided across 4 electrodes. The waveform and image 
depicting the waveforms will be stored in the Users/
mydata/mywaveforms directory. 

Format: function [] = NeuroModTDCSWaveform 
(riseTime,fallTime,durationAtMax,maxAmplitude,monta
geN,saveDir)

• Inputs:

• riseTime: the time over which the amplitude of 
stimulation increases from zero to maximum 
(seconds);

• fallTime: the time over which the amplitude of 
stimulation falls from maximum to to zero (seconds);

• durationAtMax: the duration of stimulation at 
maximum amplitude (seconds);

• maxAmplutude: the amplitude of stimulation at 
maximum (mA);

• montageN: the number of channels the current will 

Santa Fe Neurosciences Page !  of !30 33



NeuroMod tXES System Manual (Version 1.1)

be divided across (integer from 1-16)

• saveDir: directory where waveform files will be 
saved ('text')

• Outputs:

• File and figure saved to saveDir

• Notes:

• The NeuroMod tXES device changes the amplitude 
of the waveform only when instructed. Thus, the rise 
and fall of the waveform is specified with changes to 
the amplitude over time. However, there is no need 
to specify changes over the time of peak stimulation 
amplitude. Thus, the file size for tDCS waveforms 
does not necessarily vary with the length of 
stimulation. 

• The NeuroMod tXES Stimulator defines the tDCS 
and tACS waveforms similarly - from baseline to 
peak. This is similar to the Soterix stimulators but 
unlike the NeuroConn stimulator that defines tDCS 
from baseline to peak but tACS from peak to peak. 

• The number of subplots in the image will reflect the 
number of channels that have been included in the 
stimulation montage. 

NeuroModTRNSWaveform.m: tRNS waveforms can be 
created with user specifications using this Matlab 
function. 

Example: NeuroModTRNSWaveform(1,1,10,2,4,'/Users/
mydata/mywaveforms/') will create a random noise 
waveform that rises to maximum over 1 second and falls 
to zero over 1 second. The length of the stimulation at 
maximum current is possible will be 10 seconds. The peak 
amplitude will be +2mA. The current will be divided 
across 4 electrodes. The waveform and image depicting 
the waveforms will be stored in the Users/mydata/
mywaveforms directory. 

Format: function [] = NeuroModTRNSWaveform 
(riseTime,fallTime,durationAtMax,maxAmplitude,monta
geN,saveDir)

• Inputs:

• riseTime: the time over which the amplitude of 
stimulation increases from zero to maximum 
(seconds);

• fallTime: the time over which the amplitude of 
stimulation falls from maximum to to zero (seconds);

• durationAtMax: the duration of stimulation at 
maximum amplitude (seconds);

• maxAmplutude: the amplitude of stimulation at 
maximum (mA);

• montageN: the number of channels the current will 
be divided across (integer from 1-16)

• saveDir: directory where waveform files will be 
saved ('text')

Santa Fe Neurosciences Page !  of !31 33



NeuroMod tXES System Manual (Version 1.1)

• Outputs:

• File and Figure saved to saveDir

• Notes:

• Large waveforms negatively effect the performance 
of the NeuroMod tXES Stimulator. It is preferred to 
specify a short noise vector (10000 points) and repeat 
the noise vector for a specified number of seconds 
instead of creating a large waveform with long 
vectors of random noise. 

• tRNS waves with very small changes from one point 
to the next in the vector may exceed the 25 𝜇A 
resolution of the NeuroMod tXES device. Thus, the 
waveform will not change until the threshold is 
exceeded. 

• The NeuroMod tRNS Stimulator defines the 
amplitude of the tACS waveform from baseline to 
peak similar to the Soterix stimulators. This is unlike 
the NeuroConn stimulator that defines the 
amplitude of the waveform from peak to peak. 

• tRNS waveforms are created at 1000 samples per 
second using the Matlab function randn. The 
maximum value in the random noise vector is scaled 
to the maximum specified current. All other values 
in the noise vector are scaled by the same factor. 

• The number of subplots in the image will reflect the 
number of channels that have been included in the 

stimulation montage. 

NeuroMod tXES Waveforms: Custom Matlab scripts are 
available to create pulsed, windowed, multifrequency, 
evoked response based, and other waveforms. The user 
can also program the waveforms that conform to the tXES 
.wf format. The format of the waveform files is a four 
column matrix in CSV format. The first column gives the 
times when the amplitude of the current should be 
updated. The second column gives the channel numbers. 
The third column gives the values in mA for the 
stimulation waveform. The fourth column contains a 
vector of zeros. The time and amplitude vectors much be 
repeated for each channel. Please consult with the experts 
at Brain Visions or Santa Fe Neurosciences before 
attempting to create your own waveforms. 

NeuroModWaveformPlotter.m: This Matlab function 
plots the contents of any waveform file. 

Example: NeuroModWaveformPlotter(‘User/myData/
myWaveforms’,’myWaveform’)

Format: function [] = NeuroModWaveformPlotter 
(saveDir,waveform2plot)

• Inputs:

• saveDir: directory where waveform files will be 
saved ('text')

• waveform2plot: the waveform file to plot without 
the .wf extension ('text')
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• Outputs:

• Image saved to saveDir

• Notes: 

• Waveforms can be viewed but not created using this 
function. 

• Matlab will overwrite previous images of a 
waveform with the image shown with this function. 

• The number of subplots in the image will reflect the 
number of channels that have been included in the 
stimulation montage. 
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